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1. Introduction to the Virtua Profiler 

 
he Virtua Profiler lets you customize almost every aspect of the VirtuaTM 
ILS – Integrated Library System, and it offers all the benefits of a graphical 
user interface (GUI) running under a Windows 20001 or Windows XP 

operating system. In addition, the Virtua Profiler lets you perform tasks efficiently 
because it connects directly to the Oracle database.  
 

Note: From this point on, we will refer to the Virtua ILS – Integrated Library System 
as simply Virtua or the Virtua system in this guide. 

 
Using the Virtua Profiler, you can . . . 
 

 Set up, view, and edit parameters that affect each Virtua subsystem. 

 Set up user profiles for the Virtua system. 

 Configure Views of records that appear in the OPAC. 

 Configure keyword indexing rules for your system.  
 
This chapter covers the following topics:  
 

 Using This Guide 

 Diagram of the Interactions of the Virtua Profiler 

 

1.1 Using This Guide 

 
The Virtua Profiler Getting Started Primer is one of six user’s guides that make up the 
documentation for the Virtua Profiler. The other guides are . . . 
 

 Virtua Profiler/Global Settings User’s Guide - Provides details on parameters that 
appear on the Global Settings tab of the Virtua Profiler, including information on 
setting user permissions and library locations parameters.  

 Virtua Profiler/Cataloging Parameters User’s Guide - Provides details on setting 
parameters that appear on the Cataloging tab of the Virtua Profiler, including 
information on configuring keyword searching.  

                                                 
1 Windows is a registered trademark of Microsoft Corporation in the United States and other countries. 

T 
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 Virtua Profiler/OPAC Parameters User’s Guide - Provides details on setting 
parameters that appear on the OPAC tab of the Virtua Profiler, including how to 
configure MARC views. 

 Virtua Profiler/Circulation Parameters User’s Guide - Provides details on setting 
parameters that appear on the Circulation tab of the Virtua Profiler, including 
circulation matrices and location-specific circulation parameters.  

 Virtua Profiler/Acquisitions Parameters User’s Guide - Provides details on setting 
parameters that appear on the Acquisitions tab of the Virtua Profiler, including 
Purchase Request parameters. 

 
This primer provides information about the general features of the Virtua Profiler, 
including its interactions with the database, the tree structure, tabs, menu bar, pop-up 
menus, and pop-up help. We also provide details on setting defaults, configuring Local 
Service Names, and logging in to the Profiler for the first time. Throughout this guide, 
we assume that you have read the Virtua Client Getting Started Primer, which offers an 
overview of the Virtua system and an explanation of terminology. 
 
You can use the list below and the Table of Contents to locate specific information in 
this guide. For your easy reference, this guide also contains a Table of Figures and an  
Index. In addition, each chapter in this guide begins with a list of topics that are 
included in the chapter, and each topic is hyperlinked to the appropriate section. 
 
For . . .  See . . . 
  
A diagram of the interactions of the Virtua Profiler Section 1.2 
  
Details on setting defaults, configuring Local Service 
Names, and logging in to the Virtua Profiler  

Chapter 2 

  
An overview of the Virtua Profiler and descriptions of the 
tree structure, tabs, menu bar, pop-up menus, and help 

Chapter 3 

  
Details on windows, tables, and other common features of 
the Virtua Profiler 

Chapter 4 

Information on the recommended order in which to set 
your Virtua Profiler parameters 

Appendix A 

  
Details on the changes that were made to update this user’s 
guide from the last version. 

Appendix B 

 

Note: Throughout the Virtua Profiler Getting Started Primer, we assume that you are 
familiar with your Windows 2000 or Windows XP operating system.  
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1.2 Diagram of the Interactions of the 

Virtua Profiler 

 
The Virtua Profiler is part of a two-tier, client/database system. 
 
 
 
 Client (PC) 

Applications 

Database 

SQLNET, TCP/IP 

Virtua Profiler 
(profiler.exe) 

Operating System:  
Windows XP 

Virtua 
Database 
Oracle 11g 

Oracle 
Listener 
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2. Getting Started 

 
efore you can begin working with parameters, you must first log in to the 
Virtua Profiler. Before you can log in to the Profiler, however, you must 
complete various configuration tasks, which we describe in this chapter. 

 

Note: The first three topics in this chapter are also discussed in the Virtua Installation 
User’s Guide. You must complete these tasks before you log in to the Profiler. If you 
have already completed these tasks, you can skip ahead to the section “Logging in to 
the Virtua Profiler” in this chapter.  

 
This chapter covers the following topics:  
 

 Configuring Local Net Service Names 

 Setting Windows Time and Date Defaults 

 Configuring Oracle NLS_LANG Settings 

 Logging in to the Virtua Profiler 

 

2.1 Configuring Local Net Service 

Names 

 
By configuring Local Net Service Names, you specify which databases you can access 
via the Virtua Profiler. To configure Local Net Service Names, you need to run the 
Oracle Net Manager.  
 

Note: Running the Oracle Net Manager generates a new tnsnames.ora file. If you 
backed up your tnsnames.ora file from a previous installation of the Oracle Net 
Client, you need to insert the backup file in the \network\ADMIN directory of your 
Oracle 11g installation before you configure other Local Net Service Names. 

 
To run the Oracle Net Manager, 
 
1. On your Windows taskbar, click Start/All Programs/Oracle - 

OraClient11g_home1. 

Note: The name of your shortcut path may vary slightly. 

 

B 
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2. Select Configuration and Migration Tools. 
 
3. Select Net Manager. 
 

The Oracle Net Manager Welcome screen appears (Figure 2-1). 
 
 

 

Figure 2-1. Oracle Net Manager - Welcome Screen 

 
4. Expand the tree structure and select Service Naming (Figure 2-2).  
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Figure 2-2. Oracle Net Manager - Tree Structure 

 

5. Click the green plus sign icon  to display the Net Service Name Wizard 
Welcome screen (Figure 2-3). 
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Figure 2-3. Oracle Net Manager - Net Service Name Wizard Welcome Screen 

 
6. In the Net Service Name field, type a unique name for your database.  

Note: We recommend that you use the server name where the database resides 
followed by the database number, for example, apollo01 or venus81. Do NOT 
include parentheses in this name. 

 
7. Click the Next button to view the Net Service Name Wizard, Protocol screen 

(Figure 2-4). 
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Figure 2-4. Oracle Net Manager - Net Service Name Wizard Protocol Screen 

 
8. Select TCP/IP (Internet Protocol), and then click the Next button to view the 

Protocol Settings screen (Figure 2-5). 
 
 

 

Figure 2-5. Oracle Net Manager - Net Service Name Wizard Protocol Settings Screen 
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9. In the Host Name field, type the IP address or the host name of the server, for 

example, 100.15.15.101 or zeus.library.edu. 
 

10. If the Oracle Listener on the database you specified listens for a connection on a 
port other than 1521, type the port number in the Port Number field. Otherwise, 
accept the standard port number of 1521. 

 
11. Click the Next button to proceed to the Service screen (Figure 2-6). 

 
 

 

Figure 2-6. Oracle Net Manager - Net Service Name Wizard Service Screen 

 
12. In the Service Name field, type your database’s System Identifier. Use the name of 

the database as it is declared on the server. Virtua databases are vtls##, where ## 
is the database number, for example, vtls01. 
 

13. Click the Next button to proceed to the Net Service Name Configuration, Test 
screen (Figure 2-7). 
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Figure 2-7. Oracle Net Manager - Net Service Name Wizard Test Screen 

 
14. Click the Test button to test the new configuration. 

 
The Oracle client attempts to connect to the database using a default password for 
Oracle databases. This connection attempt will fail. Information about the failed 
test will be displayed on the Connection Test screen (Figure 2-8). 
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Figure 2-8. Connection Test Screen - Failure Message 

 
15. Click the Change Log-in button to view the Log-in dialog with the default 

connection information (Figure 2-9). 
 
 

 

Figure 2-9. Log-in Dialog Box 
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16. Type the Oracle username and password for the database to which you are setting 
up a connection. 

 
17. Click the OK button to return to the Connection Test screen (Figure 2-8). 

 
18. Click the Test button to test the new username and password you entered. 
 

If the username/password you entered is correct, the Connection Test screen will 
display a confirmation message (Figure 2-10). 

 
 

 

Figure 2-10. Connection Test Screen - Confirmation Message 

 
19. Click the Close button close the Connection Test screen and return to the Test 

screen (Figure 2-7). 
 

20. On the Test screen, click the Finish button. The Oracle Net Manager main 
window appears, with your new Local Net Service Name highlighted in the tree 
structure (Figure 2-11). 
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Figure 2-11. Oracle Net Manager - Displaying New Local Net Service Name 

 
21. If you would like to configure another Local Net Service Name, return to step 4 of 

this workflow. 
-OR- 
If you have finished adding Local Net Service Names, select Save Network 
Configuration from the File menu (Figure 2-12). 
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Figure 2-12. Oracle Net Manager - File Menu 

 
22. Once you have saved your network configuration settings, click Exit to close the 

Oracle Net Manager. 
 

2.2 Setting the Windows Time and Date 

Defaults 

 
In order for the Virtua Profiler to work properly, two default settings must be set 
correctly for your Windows operating system: 
 

 Time Display 

 Date Format 
 
The Virtua Profiler uses the format of your Windows time and date settings for 
displaying times and dates within parameters. For example, when you set up the 
Library Hours parameter, you will set your library hours according to the date format 
selected for your Windows operating system.  
 
Below we provide instructions for setting the Time and Date defaults for your 
Windows® XP operating system. If you are using a different Windows operating 
system, your procedures may vary slightly from those provided below.  
 

Important: You must set the Time Display and the Date Format before you log in to 
the Virtua Profiler. 
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2.2.1 Setting the Time Display 
 
To set the proper Time Display for a Windows XP operating system, 
 
1. On the Windows taskbar, click the Start button. 
2. Choose Settings/Control Panel/Regional and Language Options. 

 
The Regional and Language Options window appears (Figure 2-13). 
 
 

 

Figure 2-13. Regional and Language Options Window 

 
3. On the Regional and Language Options window, click the Customize button 

(Figure 2-15). The Customize Regional Options window appears. 
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Figure 2-14. Customize Regional Options Window 

 
4. Click the Time tab. 
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Figure 2-15. Regional Options Window - Time Tab 

 
5. Choose an appropriate Time Format.  

 
6. In the pull-down list boxes labeled AM Symbol and PM Symbol, make sure the 

symbols for AM and PM are exactly that: AM and PM, with no periods. 
 

7. Click OK.  
 
Your settings are applied. The time display you chose will appear throughout the 
Profiler.  
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2.2.2 Setting the Date Format 
 
To set the proper Date Format for a Windows XP operating system, 
 
1. On the Windows taskbar, click the Start button. 
2. Choose Settings/Control Panel/Regional Options. 
 

The Regional and Language Options window appears (Figure 2-13). 
 

3. On the Regional Options window, click the Customize button. The Customize 
Regional Options window appears (Figure 2-16). 

 
4. Click the Date tab.  

 
 

 

Figure 2-16. Customize Regional Options Window - Date Tab 
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5. In the drop-down list box labeled Short Date Format, choose a date format with a 
four-digit year, and then click OK.  
 
Your settings are applied. The date format you chose will be used throughout the 
Profiler.  

 

2.3 Configuring Oracle NLS_LANG 

Settings 

 
For your Virtua Profiler to display and write UTF-8 characters, the Oracle 
NLS_LANG settings on your PC must match the NLS_LANG settings in your Virtua 
database. The NLS_LANG setting for ALL Virtua databases is AL32UTF8.  
 
When you launch the Virtua Profiler, Virtua checks to make sure that your 
NLS_LANG setting is properly configured. If it is NOT set correctly, the following 
message appears (Figure 2-17). 
 
 

 

Figure 2-17. Error Message Displayed When NLS_LANG Setting Is Incorrect 

 

Note: The Virtua Profiler configures the message to be appropriate for the locality of 
your PC. For example, Figure 2-17 shows the message that would appear on a machine 
where the locality is AMERICAN_AMERICA. 

 
Click the Yes button to change your NLS_LANG setting to AL32UTF8. If you click 
the No button, the Connect menu item will be disabled on the File menu, and you will 
not be able to log in to the Virtua Profiler. 
 

Note: After the NLS_LANG setting is properly configured, this message will NOT 
appear when you launch the Profiler.  
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2.4 Logging In to the Virtua Profiler 

 
You are ready to launch the Virtua Profiler after you have . . . 
 

 Successfully installed the Virtua Profiler by following the installation procedures in 
the Virtua Installation User’s Guide. 

 Configured your Local Net Service Names. 

 Set the Windows Time Display and Date Format. 
 

2.4.1 Launching the Virtua Profiler 
 
To launch the Virtua Profiler, 
 

 On the Windows Start menu, choose Programs/VTLS/Profiler. 
 
Virtua checks your NLS_LANG setting (see the section “Configuring Oracle 
NLS_LANG Settings”). If it is properly configured, the Virtua Profiler main 
window appears (Figure 2-18). 
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Figure 2-18. Virtua Profiler Main Window 

 
At the bottom of the window, the status bar displays NOT CONNECTED. 

 

2.4.2 Connecting to a Database and Logging in to the 
Profiler 
 
To connect to an Oracle database and log in to the Virtua Profiler,  

 
1. On the menu bar, click File. 
2. Choose Connect. 
 

Note: The Connect menu item is enabled only if you have the Oracle Client 
installed and if your Oracle NLS_LANG setting is properly configured.  
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The Log-in dialog box appears (Figure 2-19). 
 

 

Figure 2-19. Virtua Profiler Log-in Box 

 
3. In the Oracle Log-in area, type your Oracle username and password in the 

appropriate text boxes. 
 

4. In the Database drop-down list box, select a database.  
 

Note: This list box contains the Local Net Service Names that you configured 
with the Net Configuration Assistant. For details, see the section “Configuring 
Local Net Service Names” in this chapter. 

 
5. If you want your Oracle log-in information to be remembered the next time you 

log in to the Virtua Profiler, select the Remember Log-in check box.. 
 

Note: If you select the Remember Log-in check box, the next time you log in to 
the Virtua Profiler, the Oracle username and database that you selected for the 
previous log-in will be supplied for you.  

 
6. In the Virtua Log-in area, type your Virtua username and password in the 

appropriate text boxes, and then click OK. 
 

Note: You can log in using any User Profile that has permission to access the 
Profiler. Throughout this guide, however, we assume that you are logged in as 
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root, which gives you access to all the features in the Virtua Profiler. For details on 
User Profiles, see the Virtua Profiler/Global Settings User’s Guide. 

 
An Oracle channel or connection is established between the client and server using 
an Oracle Client on your PC and an Oracle User Account on the server. 

 

Note: To connect to the Oracle database, an Oracle listener must be running. If 
you receive an error message indicating that a listener is NOT running, start a 
listener, and then try logging in again. For details on starting an Oracle listener, see 
the Virtua Installation User’s Guide.  

 
Virtua then authenticates your username and password. If Virtua is able to validate 
your user profile, it initializes and configures the main window of the Virtua 
Profiler according to your user permissions (Figure 2-20).  
 
 

 

Figure 2-20. Virtua Profiler Main Window 
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The content of the Virtua Profiler main window will vary, depending on your user 
permissions. For details on viewing the Virtua Profiler window, see the following 
chapter, “Getting Oriented.” 
 

Note: After you have established a connection, you can use the Connect option on the 
File menu to change your connection at any time during your session.  

 

2.4.3 Locked Oracle User Accounts: What to Do 
 
When you log in to the Virtua Profiler several times using an incorrect Oracle 
password, the system “locks” the Oracle user account so that you cannot attempt any 
more log ins. You need to run a script to unlock the Oracle user account. 
 
To unlock an Oracle user account, 
 
1. Log in to your server as the dbadmin user. 
 
2. Type: ./unlockProfilerAccount.sh <user_account_name> 

 
…where [<user_account_name>] is the username assigned to the Oracle user in 
the database.  
 

3. Press Enter. 
 

The script unlocks the user. 
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3. Getting Oriented 

 
n this chapter, we describe the aspects of the Virtua Profiler main window, 
provide hints for navigating the Profiler, and discuss general parameter 
characteristics. In addition, this chapter contains an overview of the editing 

functions that are available throughout the Profiler.  
 
This chapter covers the following topics:  
 

 Working with Tabs on the Profiler Main Window 

 Working with the Profiler “Tree” Structure 

 Working with the Profiler Menu Bar 

 About the Pop-up Menu 

 Setting the Font of the Virtua Profiler 

 Getting Help with the Virtua Profiler 

 

3.1 Working with Tabs on the Profiler 

Main Window 

 
After you log in to the Virtua Profiler, the Virtua Profiler main window appears (Figure 
3-1). 
 

I 
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Figure 3-1. Virtua Profiler Main Window 

 
The status bar at the bottom of the window indicates the database and server to which 
you are connected. The tnsnames alias is displayed in parentheses in the status bar. 
 

Note: The tnsnames alias is specified in the tnsnames.ora file, and appears in the 
Database drop-down list on the Profiler’s Log-in window (Figure 2-19). 

 
 
The main window can display up to five tabs, depending on the functions your user 
permissions allow. For details on User Profiles, see the Virtua Profiler/Global Settings 
User’s Guide.  
 
Four tabs relate to specific subsystems: OPAC, Cataloging, Circulation, and 
Acquisitions. One tab, Global Settings, contains settings that control functions 
throughout your entire system. At least one tab must appear for you to use the Virtua 
Profiler.  
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You can view the parameters associated with a particular tab by clicking that tab and 
then expanding the first heading in the tree. For details, see the following section. 
 

3.2 Working with the Profiler “Tree” 

Structure 

 
Each tab on the Virtua Profiler main window has a “tree” structure that represents the 
hierarchy of the parameters on that tab. Using your mouse or your keyboard, you can 
navigate the Profiler by expanding and collapsing the tree. 
 
The tree structure builds dynamically, meaning that the Virtua Profiler does not build 
all the branches of the trees at once. Rather, as you select an item, or heading, the 
Virtua Profiler builds that part of the structure. When you click a heading, if one or 
more subheadings exist, a plus sign (+) appears to the left of the primary heading. 
When you click the plus sign or double-click the heading, the plus sign changes to a 
minus sign (-), indicating that the branch of the tree is fully expanded.  
 

Note: The settings for user permissions are organized using a similar tree structure. 
For details on user permissions, see the Virtua Profiler/Global Settings User’s Guide. 

 
In this chapter, we describe several ways in which you can expand and collapse the 
Virtua Profiler tree structure. For simplicity, however, throughout this user’s guide and 
in the other Virtua Profiler user’s guides, we use only the double-click method in our 
step-by step instructions. Keep in mind that all of the following methods are available 
to you. 
 

3.2.1 Expanding the Tree 
 
To expand the tree structure of a heading, 
 

 Double-click the heading. 
-OR- 

 Click the plus sign (+) to the left of a heading. 
-OR- 

 Highlight a heading that has a plus sign (+), and then press the RIGHT arrow key 
on your keyboard. 
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Note that when you click a plus sign (+), it changes to a minus sign (-) to indicate 
that the heading is expanded. 

 

3.2.2 Collapsing the Tree 
 
To collapse the tree structure of a heading, 

 

 Double-click the heading. 
-OR- 

 Click the minus sign (-) to the left of a heading. 
-OR- 

 Highlight the heading, and then press the LEFT arrow key on your keyboard. 
 

Note that when you click a minus sign (-), it changes to a plus sign (+) to indicate 
that the heading is not expanded. 

 

3.2.3 Viewing and Editing a Fully Expanded Item 
 
In most cases, you can view and/or edit only those items that have been fully 
expanded.  
 
To view and/or edit a fully expanded item, 
 

 Double-click the item. 
 

A window associated with the selected heading appears. The main window is 
disabled while any parameter-specific window is open. 

 

3.2.4 Understanding Tree “Paths” in this Guide 
 
Throughout this guide and in the other Virtua Profiler user’s guides, we provide you 
with step-by-step instructions for finding items in the Virtua Profiler tree structure. In 
some cases, however, we abbreviate instructions by indicating the path to a branch in 
the tree.  
 
For example, to simplify a path to a specify library location, which you define via the 
Location Names parameter, we would indicate the path to the window in the following 
manner:  
 
Global Settings tab/SYSTEM/Location Names/Kenmore Art Library/East Branch 
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When we represent a path in this way, you can assume that a double-click on the last 
item in the path (in this case, East Branch) will display the relevant window (in this 
case, Modify Sublocation).  
 

3.3 Working with the Profiler Menu Bar 

 
The Virtua Profiler menu bar offers five menus: File, Edit, System, Options, and Help.  

 

3.3.1 File Menu 
 

 
Figure 3-2. File Menu 

 
The File menu offers the following menu items: 
 

 Connect - Displays the Log-in dialog box, where you can connect to a different 
database and/or as a different Virtua User. For details, see the section “Logging In 
to the Virtua Profiler” in this user’s guide.  

 

 Import New Permissions - Lets you import the permissions associated with the 
latest Virtua client while keeping the permissions already set in your database. 
Every time you install a new version of the Profiler, you must use this feature (for 
details, see the Virtua Profiler/Global Settings User’s Guide.)  

 

 Copy Parameters - Displays the Parameter Copy Utility window, where you can 
copy Virtua Profiler parameters from one database to another. For details, see the 
chapter “Working with the Parameter Copy Utility” in this user’s guide.  

 

 MARC View Editor - Displays the MARC View Editor window, where you can 
edit View records. For details, see the Virtua Profiler/Global Settings User’s Guide.  

 

 Exit - Logs you out of the Virtua Profiler and closes the Virtua Profiler main 
window. 
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3.3.2 Edit Menu 
 
The Edit menu (Figure 3-3) displays three options: Add, Modify, and Delete. 

 

 

Figure 3-3. Edit Menu 

 

 Add - Lets you add a new item to the tree. The new item is added under the 
highlighted item.  

 Delete - Lets you delete the highlighted item. In most cases, you receive a 
confirmation message before the item is deleted.  

 Modify - Lets you modify the highlighted item.  
 

Note: These editing features work only for parameters that can be edited directly from 
the tree. 

 
The options on the Edit menu duplicate functions that are also available from the pop-
up menu and from keyboard shortcuts. For details, see the section “About the Pop-up 
Menu” in this chapter.  
 

3.3.3 System Menu 
 
The System menu (Figure 3-4) displays five options: Global Settings, OPAC, 
Circulation, Cataloging, and Acquisitions. ASR (Automated Stack Request) is available 
for flagged databases. 

 

 

Figure 3-4. System Menu 
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Each option on the System menu corresponds to a tab on the Virtua Profiler window. 
You can use this menu to switch from one tab to another. 
 

3.3.4 Options Menu 
 
The Options menu displays three options: Font, Sort Locations By, and Language. 
 

 

Figure 3-5. Options Menu 

 

 Font - Lets you choose a font for the Virtua Profiler interface. For details, see the 
section “Setting the Font of the Virtua Profiler” in this chapter.  

 

 Sort Location By - Offers a submenu with two options that let you determine 
how to sort locations in the Location Names parameter:  
 Name - Sorts locations by name. 
 Number - Sorts locations by location code.  

 

 Language - Offers a submenu of language display options for the Virtua Profiler 
interface, including permissions. Innovative will add languages to the submenu as 
translations are completed. Translations of Profiler language strings are stored in 
plang.* files, which reside in the DBTables directory of your Virtua Client 
installation (for information about translating the Virtua Profiler, see the Virtua 
Translation and String Customization Guide).  

 

Important: For the Language option to function, you must have the Virtua Client 
installed on the same PC as the Profiler. 

 

3.3.5 Help Menu 
 
The Help menu (Figure 3-6) displays two options: About and Permissions Help. 
 

 

Figure 3-6. Help Menu 
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 About - Displays Innovative copyright and license restriction information and 
version numbers for your Virtua Profiler, server, and database. 

 Permissions Help - Displays online Virtua Profiler Permissions help. For more 
information, see the section “Using Online Profiler Permissions Help” in this 
guide. 

Note: Profiler Permissions help is also available from the Help menu in the Virtua 
client. For more information see the Virtua Client Getting Started Primer. 

 

3.4 About the Pop-up Menu 

 
The editing functions that are available via the Edit pull-down menu are also available 
from a pop-up menu.  
 

Note: The pop-up menu is available only for items that support editing functions. 

 
To see the pop-up menu,  
 
1. Highlight the desired parameter. 
2. Click your right mouse button. 

 
The pop-up menu appears (Figure 3-7). 
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Figure 3-7. Pop-up Menu (Displaying Editing Functions) 

 
The pop-up menu contains the options described below. Note that next to each option 
a shortcut key combination appears and performs the same function as the menu item.   
 

 What’s This? - Displays context-sensitive help about the selected tab.  
 

 Add (CTRL+A) - Lets you add a new item to the tree. The new item is added 
under the highlighted item. For example, in Figure 3-7, the Add function would let 
you add a new sublocation to the Main Library.  

 

 Delete (CTRL+D) - Lets you delete the highlighted item. You receive a 
confirmation message before the item is deleted. For example, in Figure 3-7, the 
Delete menu item would let you delete the Main Library.  

 

 Modify (CTRL+- Lets you modify the highlighted item. For example, in Figure 
3-7, the Modify menu item would let you modify settings for the Main Library. 
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Fr details on using the What’s This? option from the pop-up menu, see the section 
“Getting Help with the Virtua Profiler” in this chapter.  
 

3.5 Setting the Font of the Virtua 

Profiler 

 
You can use the Font option, which is available on the Options menu, to set the font 
of the Virtua Profiler. 
 

Important: When you set the font of the Virtua Profiler, keep in mind that . . . 

 Large fonts can cause text to run off its window or control. We recommend that 
you do NOT choose a font size that is larger than the default font. Depending on 
the font style you select, you may need to adjust the font point size to keep the 
font the same size as the default font. 

 When installing fonts, keep in mind that some fonts use more disk space than 
others. For example, Arial Unicode MS uses approximately 30 MB of disk space, 
whereas Tahoma, the default font of Virtua, uses about 0.5 MB.  

 
To choose the font of the Virtua Profiler,  
 
1. On the Virtua Profiler menu bar, click Options.  
2. Choose Font.  

 
The Font window appears (Figure 3-8).  
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Figure 3-8. Font Window 

 
3. Choose the desired font, font style and size, and then click OK.  
 

The font of the Virtua Profiler main window and all parameter windows changes 
as appropriate.  
 

Note: The font of some strings, such as menu items, is determined by the display 
settings defined for your Windows operating system. The Virtua Profiler’s Font option 
does not affect the font of these strings. For details on configuring your Windows 
display settings, consult your Windows documentation.  
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3.6 Getting Help with the Virtua 

Profiler 

 

3.6.1 Using Context-sensitive Help 
 
Context-sensitive help lets you complete tasks both easily and efficiently by providing 
you brief information about the aspects of the window or dialog box that you are 
viewing. Context-sensitive help is available on each window in the Virtua Profiler. By 
clicking your right mouse button, you can get context-sensitive help for objects such as 
buttons, list boxes, check boxes, and radio buttons. These screen tips are known as 
What’s This? pop-up help. 
 
To see the What’s This? help for a feature, 
 
1. Point your mouse cursor at the feature in question. 
2. Click the right mouse button.  

 
A What’s This? pop-up appears (Figure 3-9), either alone or as part of a menu. 

 
 

 

Figure 3-9. What's This? Help Menus 

 
3. Click the What’s This? option. 

 
The appropriate screen tip appears (Figure 3-10). 
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Figure 3-10. What's This? Screen Tip 

 
4. When you are finished reading the screen tip, click anywhere on the screen. 
 

The What’s This? screen tip disappears.  
 
For details on getting help via the Virtua System Guides, see the Virtua Getting 
Started Primer.  

 

3.6.2 Using Online Profiler Permissions Help  
 
Virtua Profiler Permissions help makes it easy for you to determine which permission 
setting in the Virtua Profiler corresponds to a particular feature in the client and vice 
versa. 
 
You can access online Profiler Permissions help in the Virtua Profiler in two ways: 
 
1. From the Help menu on the Virtua Profiler menu bar. 
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-OR- 
 

2. From the Help button on the Add/Modify User window. 
 

Note: You can access the Help menu on the Virtua Profiler menu bar only if you do 
not have a Virtua Profiler parameter window open. While setting permissions, use the 
Help button on the Add/Modify User window to access Profiler Permissions help. 

 
 
To display Profiler Permissions help from the Help menu on the Virtua Profiler 
menu bar… 
 
1. On the Virtua Profiler menu bar, click Help. 

The Help menu drops down. 
 

2. Choose Permissions Help.  
 
The Profiler Permissions help window appears (Figure 3-11).  
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Figure 3-11 - Profiler Permissions Help Window 

 
To display Profiler Permissions help using the Help button on the Add/Modify 
User Window… 
 
1. On the Add/Modify User Window, click the Help button (Figure 3-12). 

The Profiler Permissions help window appears (Figure 3-11). 
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Figure 3-12 - Modify User Window 
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4. About Common Features and 

Procedures 

 
ach Virtua Profiler parameter appears on its own window, which is 
accessible from the Virtua Profiler tree and contains settings that are specific 
to that parameter. While each parameter offers different configurable 

settings, the windows on which the parameters appear have common features and 
offer similar functions. As such, you will perform many of the same procedures 
repeatedly throughout the Virtua Profiler.  
 
In this chapter we provide descriptions of some of the global features that you will see 
throughout the Virtua Profiler. Additionally, we provide step-by-step instructions for 
tasks that you will perform repeatedly while configuring parameters in the Virtua 
Profiler.  
 

Important: To avoid repetition, in this and other Virtua Profiler user’s guides, we 
assume that you are familiar with the features and tasks described in this chapter. In 
general, we do not repeat this information elsewhere.  

 
This chapter covers the following topics: 
 

 Types of Windows Used in the Virtua Profiler 

 General Window Features 

 Working with Tables 

 Using the Pop-up Calendar to Set Dates 

 A Note About Character Limits 

 

4.1 Types of Windows Used in the 

Virtua Profiler 

 
Four basic types of windows are used throughout the Virtua Profiler. 
 

 Windows with a single drop-down list box.  

 Windows with a table and an Add button. 

 Windows with input boxes and/or tabs.  

E 
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 Windows with a table and NO Add button. 
 
A basic understanding of these types of windows and their features can help you 
determine what you must do to configure a parameter that appears on a particular type 
of window.  
 

4.1.1 Windows with One or More Drop-down List Boxes 
 
The simplest window design offers one or more pull-down list box, a Save or OK 
button, and a Cancel button. The Minimum Circulation Question window (Circulation 
tab/System Parameters/Minimum Circulation Question) is an example of the simplest 
window, where you must choose either YES or NO from the drop-down list box 
(Figure 4-1).  
 

 

 

Figure 4-1. Minimum Circulation Question Window (Simple Window with Pull-down List Box) 

 

4.1.2 Windows with a Table and an Add Button 
 
A second type of window displays a table containing one or more columns and rows. 
An Add button appears on these windows. The Shipping Methods window 
(Acquisitions tab/Shipping Methods) is an example of a window with a table and an 
Add button (Figure 4-2).  
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Figure 4-2. Shipping Methods (Window with Table and Add Button) 

 

Note: In most cases, a window with an Add button also contains a Delete button or a 
Remove button, which lets you delete rows from the table.  

 

4.1.3 Windows with Input Boxes and Tabs 
 
A third type of window contains a variety of input fields and may contain multiple tabs 
to organize complex data. Circulation Matrix windows contain input boxes and 
multiple tabs. For example, in Figure 4-3, we show an example of the Location + 
Patron + Item Matrix window (Circulation tab/Circulation/Location + Patron + 
Item/Main Library/Faculty/Fiction).  
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Figure 4-3. Location + Patron + Item Matrix Window (Input Boxes and Multiple Tabs) 

 

4.1.4 Windows with a Table and NO Add Button 
 
The fourth type of window contains a table but NO Add button. Check-out Limits 
Matrix windows contain a table but no Add button. For example, in Figure 4-4 we 
show the Faculty Block/Alert Matrix window (Circulation tab/Circulation/Alerts & 
Blocks/Faculty).  
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Figure 4-4. Block Alert Matrix (Table and NO Add Button) 

 
On this type of window, you can edit the data in the cells of the table, but you cannot 
add new rows. New rows, however, may be added to the table as a result of additions 
to other parameters.  
 

4.2 General Window Features 

 
Each window in the Virtua Profiler contains the following two buttons:  
 

 Save or OK - Saves to the database the changes that you made on the window. 
After you configure a parameter, you must click the Save button for the settings to 
be saved to the database.  

 

 Cancel - Cancels any changes that you made and closes the window. 
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Additionally, all windows display a status bar at the bottom that indicates either . . . 
 

 NOT SET!   
 

Note: All parameters maintain their NOT SET status until you save them for the 
first time.  

 
-OR-  
 

 The date and time the parameter was last saved. 
 

4.3 Working with Tables 

 
When a parameter window contains a table, you can . . .  
 

 Edit the information in the table.  

 If the window contains an Add button, add a row to the table. 

 If the table contains a Delete button, delete a row from the table.  
 

Note: In some cases, you can delete rows from a table even if the window does 
not contain a Delete button.  

 

4.3.1 Editing Information in a Table 
 
To edit information in a table, you can . . . 
 

 Add text to an empty cell. 
-OR-  

 Edit existing text. 
-OR- 

 Select an option from a drop-down list box in a cell. 
 

For cells that contain a drop-down list box (Figure 4-5), the box usually does not 
appear until you click twice in the cell. It disappears when you click somewhere else 
in the table. 
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Figure 4-5. Editing Table Rows 

 
Data in some cells cannot be edited or deleted. This is because some data are hard 
coded in Virtua and are crucial to the operations of the Virtua Profiler. Usually, if data 
cannot be edited or deleted, Virtua does not let you highlight the cells that contain the 
data. 
 

4.3.2 Adding New Rows to Tables 
 

To add a new row to a table, 
 

 Click the Add button. 
 
The cursor will automatically go to the beginning of the first column, ready for 
your first entry.  
 

Note:  

 You can add rows to a table only if the window displays an Add button. 



48  Virtua Profiler Getting Started Primer (v. 16.1) 

PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC. 

 You must complete the data in each cell of a row; otherwise, Virtua will not save 
the changes in that row. 

 In most cases, you cannot add a new row until you have completely filled the 
previous row. 

 

4.3.3 Deleting Rows from Tables 
 
Windows that contain tables also contain a Delete button or a Remove button, which 
lets you delete rows from the table.  
 
To delete a row from a table, 
 
1. Highlight any cell in the row that you want to delete. 
2. Click the Delete button or the Remove button, as appropriate. 
3. Click the Save button. 

 
The row is deleted from the table. 

 

Note: Information is not deleted from the database until you click the Save button. 
Additionally, in some cases, when you click the Save button, you receive a 
confirmation message that asks you to confirm the deletion.   

 

4.4 Using the Pop-up Calendar to Set 

Dates 

 
Some parameters require that you to set various dates. For example, via the Location 
Names parameter, you set the Default Reserve Start Date and the Default Reserve End 
Date on the Add/Modify Main Location window. To facilitate date-setting, Virtua 
offers a pop-up calendar.  
 
To access the pop-up calendar, 
 
1. Click the down arrow in the desired date field.  

 

Note: If the date field appears in a table, you must click the cell twice to see the 
down arrow.   

 



Virtua Profiler Getting Started Primer (v. 16.1)  49 

PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC. 

The pop-up calendar appears (Figure 4-6). 
 

 

Figure 4-6. Pop-up Calendar 

 
2. Use the arrows at the top of the calendar to choose a different month and/or year. 
3. When you find the desired month and year, click the desired day of the month. 
 

Note: You can also navigate the calendar using the arrow keys on your keyboard. 

 
The calendar closes, and the date you chose appears in the appropriate cell.  
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4.5 A Note about Character Limits 

 
Theoretically, information you enter for statuses, location names, and other user-
defined descriptions can have strings that are hundreds of characters in length. 
Throughout Virtua, however, the fields that display these descriptions can show only a 
limited number of characters. Any characters that go beyond the display capabilities of a 
particular field will NOT be visible. 
 
For example, in Figure 4-7, the Location name field contains more characters than the 
window can display. The server stores the information correctly, but it is NOT visible 
to the user. Smaller windows will display fewer characters. 
 
 

 

Figure 4-7. Add New User Window (Displaying Long Names) 
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The number of characters that will appear in a field depends upon . . . 
 

 The character set and font you use. 

 The display settings of your Windows operating system. 
 

Hint: As a general rule, we recommend that you limit your descriptions to 35 
characters. 
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5. Working with the Parameter Copy 

Utility 

 
he Virtua Profiler offers a utility that lets you copy the parameter settings 
from one database to another database. In this chapter, we describe how you 
can use the Parameter Copy Utility to copy parameters across databases.  

 

Caution: The Parameter Copy Utility will overwrite any existing parameter settings in 
your target database. This change is irreversible and will affect the behavior of your 
database. If your target database already contains parameter settings, we suggest that 
you back up your database before you use the Parameter Copy Utility.  

 
The success of the copying task depends on a number of elements. Be aware that 
when we designed the Parameter Copy Utility, we did so based on the following 
assumptions and conditions: 
 
1. The source and target databases are on the same major release. 
2. The source and target databases were created as copies of one another. 
3. When connecting to the source and target databases, you use the dbadmin user. 
 
It is important to note that the source parameters replace the target values; they do not 
merge with them. The target database will end up being an exact copy of the source database. This 
means that if the target database contains a parameter, say, a new location that does 
not exist in the source database, then when you copy locations from the source to the 
target, the new location will be removed.  
 

Note: If a location on the target database does not exist on the source, and this 
location is in use on the target, Virtua will not be able to copy locations. As a result, 
the report generated by the process will display the following error:  
Fatal error occurred. Reason: ORA-02091: transaction rolled back 

ORA-02292: integrity constraint (DBADMIN.FK2_USERS) violated - 

child record found. No parameters were copied.  
To get around this situation and to synchronize locations, before running the utility, 
first copy the locations from the target database to the source. 

 

T 



Virtua Profiler Getting Started Primer (v. 16.1)  53 

PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC. 

This chapter covers the following topics: 
 

 Accessing the Parameter Copy Utility 

 Aspects of the Parameter Copy Utility Window 

 Copying Parameters from One Database to Another 
 

5.1 Accessing the Parameter Copy 

Utility 

 
To access the Parameter Copy Utility, 
 

 On the Virtua Profiler menu bar, click File, and choose Copy Parameters. 
 

The Parameter Copy Utility window appears (Figure 5-1).  
 
 

 

Figure 5-1. Parameter Copy Utility Window 
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5.2 Aspects of the Parameter Copy 

Utility Window 

 
You can use the Parameter Copy Utility window to select options for copying 
parameters from one database to another. In the following sections, we describe the 
elements of the Parameter Copy Utility window.  
 

5.2.1 Pull-down Menus on the Parameter Copy Utility 
Window 
 
The Parameter Copy Utility window contains two pull-down menus: Connect and 
Data Load.  
 

5.2.1.1  Connect Menu 

 

 

Figure 5-2. Connect Menu 

 
The Connect menu offers the following menu items: 
 

 Source - Displays the Log-in dialog box, where you can connect to the source 
database (i.e., the database from which you want to copy parameter settings).  

 Target - Displays the Log-in dialog box, where you can connect to the target 
database (i.e., the database to which you want to copy parameter settings).  

 

5.2.1.2  Data Load? Menu 

 

 

Figure 5-3. Data Load? Menu 

 
The Data Load? menu offers one menu item: 
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 Migrate Data Load Parameters - Controls the setting that determines whether 
to copy data load parameters, which are parameters that must be copied prior to 
the initial loading of data into the database. Data load parameters are designated 
with the label (data load) in the parameter tree structure on the Parameter Copy 
Utility window.  

 

 
 

 The Migrate Data Load Parameters menu item is a flag that has two modes: 
 

 Unchecked - Specifies that non-data load parameters will be copied. This is 
the default copy mode.  

 Checked - Specifies that data load parameters will be copied.    
 
When you click the Migrate Data Load Parameters menu item, the current setting 
of the flag toggles between checked or unchecked, as appropriate.  

 

Note: The setting of the Migrate Data Load Parameter flag determines which 
parameters you will be allowed to select for copying.  

 If the Migrate Data Load Parameter menu item is selected (i.e., the menu item is 
checked), you will able to select only data load parameters for copying.  

 If the Migrate Data Load Parameter menu item is NOT selected (i.e., the menu 
item is unchecked), you will be able to select only non-data load parameters for 
copying.  

 

5.2.2 Tabs on the Parameter Copy Utility Window 
 
The Parameter Copy Utility window contains tabs, each of which displays a tree 
structure. For the most part, the headings of the tree on each tab of the window 
correspond to the headings on each tab of the Virtua Profiler main window. 
 
Each branch of the tree on the General Settings tab of the Parameter Copy Utility 
window corresponds to a parameter that appears on the Global Settings tab on the 
Virtua Profiler main window. For example, the Currencies heading corresponds to the 
Currencies parameter, and the Users and Groups heading corresponds to the User 
Profiles parameter. 
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Each heading on the Parameter Copy Utility window has a corresponding check box, 
which lets you choose whether to copy those parameter settings from the source 
database to the target database. When you begin the parameter-copying process, all 
selected (i.e., checked) parameters will be copied to the target database.  
 

Note: When you select a check box, you are electing to copy ALL the settings 
associated with a given parameter. For example, if you select the Status Displays check 
box, you will copy ALL item status definitions from the source database to the target 
database.  

 

5.2.3 Information Bars on the Parameter Copy Utility 
Window 
 
At the bottom of the Parameter Copy Utility window, information bars indicate your 
connection status to a source and a target database. Before you have connected to a 
source and a target database, the information bars display… 
 
SOURCE - NOT CONNECTED 
TARGET - NOT CONNECTED 
 
After you have established a connection to the source and the target database, the 
information bars display the connection information. 
 

5.2.4 Status Fields on the Parameter Copy Utility 
Window 
 
At the bottom of the Parameter Copy Utility window, two status fields indicate the 
progress of your parameter copying session.  
 

 

Figure 5-4. Parameter Copying Progress Indicators 

 
The status fields are inactive until you begin the parameter-copying process. After you 
begin the process, the fields indicate… 
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 Number of parameters left to copy - Of the parameters you have selected to 
copy, the number of parameters that have not yet been copied.  

 Parameter being copied - The name and progress of the parameter currently 
being copied.  

 

Note: If you access another application after you begin the parameter-copying 
process, you will NOT be able to switch back to the Parameter Copy Utility window 
until the process is complete. If you want to monitor the progress of the parameter-
copying procedure, do NOT switch to another application after you have started the 
copying process.  

 

5.2.5 Buttons on the Parameter Copy Utility Window 
 
The Parameter Copy Utility window offers two buttons: 
 

 Uncheck All - De-selects all parameters of a given type (either data load or non-
data load) on all tabs. When you access the Parameter Copy Utility window, all non-
data load parameters are selected by default. This button lets you de-select all 
selected parameters.  

Note: When you click the Uncheck All button to de-select all parameters, the 
button label toggles to Check All. Clicking the Check All button selects all 
parameters of a given type on all tabs. 

 

 Copy - Begins the parameter-copying process.  
 

5.3 Copying Parameters from One 

Database to Another 

 
The parameter-copying process consists of the following steps: 
 

 Establishing source and target database connections.  

 Selecting the parameters that you want to copy.  

 Performing the copy process.  
 
We describe each of these steps in detail in the following sections of this chapter.  
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5.3.1 Establishing Database Connections 
 
Before you can copy parameters from one database to another, you must establish two 
database connections:  
 

 Source - The database from which you want to copy parameters.  

 Target - The database to which you want to copy parameters.  
 

Note: You can establish database connections either before or after you select 
parameters for copying. For details on selecting parameters, see the section “Selecting 
Parameters to Copy” in this chapter.  

 

5.3.1.1 Connecting to the Source Database 

 
To connect to the source database,  
 
1. On the Parameter Copy Utility window, click Connect on the menu bar. 
2. Choose Source. 

 
The Log-in dialog box appears (Figure 5-5). The Username field is already 
populated with dbadmin and cannot be edited. 
 
 

 

Figure 5-5. Source Log-in Dialog Box 

 
3. In the Password text box, type the Oracle password associated with the source 

database. 
 

4. In the Database drop-down list, select the source database, and then click OK.  
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Virtua establishes a connection to the selected database. The source database 
connection information appears in the status bar on the Parameter Copy Utility 
window (Figure 5-6). 
 
 

 

Figure 5-6. Parameter Copy Utility Window Displaying Source Connection Information 

 

5.3.1.2 Connecting to the Target Database 

 
To connect to the target database,  
 
1. On the Parameter Copy Utility window, click Connect on the menu bar. 
2. Choose Target. 

 
The Log-in dialog box appears (Figure 5-7). 
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Figure 5-7. Target Database Log-in Dialog Box 

 
3. In the Password text box, type the Oracle password associated with the target 

database. 
 

4. In the Database drop-down list, select the target database, and then click OK.  
 
Virtua establishes a connection to the selected database. The target database 
connection information appears in the status bar on the Parameter Copy Utility 
window (Figure 5-8). 
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Figure 5-8. Parameter Copy Utility Window Displaying Target Connection Information 

 

5.3.2 Selecting Parameters to Copy 
 
Before you can begin copying parameters, you need to choose which parameters to 
copy. Using the Data Load? menu option, you can choose to copy either . . .  
 

 Non-data Load Parameters  
-OR- 

 Data Load Parameters 
 
In the following sections, we describe how you can establish your data load setting and 
choose parameters for copying.  
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Note: You can select parameters for copying either before or after you connect to the 
source and target database. For details on connecting to databases, see the section 
“Establishing Database Connections” in this chapter.  

 

5.3.2.1  Establishing the Data Load Setting 

 
To establish your data load setting,  
 
1. On the Parameter Copy Utility menu bar, click Data Load?. 

 
By default, the Migrate Data Load Parameter option is unchecked. By default, all 
non-data load parameters are selected and will be copied unless you modify the 
selections. 
 

2. Retain the data load default setting. 
-OR- 
Change the setting by checking the Migrate Data Load Parameter option, in which 
case, all data load—and only data load—parameters are selected and will be copied 
unless you modify the selections. 
 

Once you have established the data load setting, and assuming you want to modify the 
default parameter selections, the next step is to select the parameters you want to copy. 
 

5.3.2.2  Selecting Non-data Load Parameters 

 
To select non-data load parameters for copying,  
 
1. On the Parameter Copy Utility menu bar, click Data Load? and verify that the 

Migrate Data Load Parameters option is unchecked.  

Hint: At this point, depending on how many default parameter selections you want 
to change, you might click the Uncheck All button to de-select all parameters and 
start from scratch.  

 
2. On the General Settings tab, select the check boxes that correspond to the 

parameters you want to copy. 
 
3. On the OPAC tab, select the parameters that you want to copy. 
 
4. On the Cataloging tab, select the parameters that you want to copy. 
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Note: Some Cataloging parameters are data load parameters. You will not be able 
to select these parameters for copying.  

 
5. On the Circulation tab, select the parameters that you want to copy. 
 
6. On the Acquisitions tab, select the parameters that you want to copy. 
 
Some parameters use and depend on settings in other parameters. Therefore, if you 
choose to copy one parameter, you may be required to copy other, related parameters 
as well. For example, the Location Names parameter requires that the Item Class 
Definitions parameter be copied. If you choose to copy the Location Names 
parameter, the following message appears (Figure 5-9): 
 
 

 

Figure 5-9. Item Class Definitions Required Message 

 
Likewise, if you choose to de-select a parameter that affects other parameters, you will 
receive a message to that effect. For example, if you de-select the Item Class 
Definitions parameter, the following message appears (Figure 5-10): 
 
 

 

Figure 5-10. Other Parameters Will Be Unchecked Message 
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5.3.2.3  Selecting Data Load Parameters 

 
To select data load parameters for copying,  
 
1. On the Parameter Copy Utility menu bar, click Data Load? and verify that the 

Migrate Data Load Parameters option is checked. 
 
On the General Settings tab, notice that all non-data load parameters are de-selected 
and shaded (Figure 5-11), indicating that they are not available for selection.  
 
 

 

Figure 5-11. Non-data Load Parameters Grayed Out 

 
2. Click the Cataloging tab. 
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On the Cataloging tab (Figure 5-12), non-data load parameters are not shaded, but 
they are de-selected and cannot be selected. When the Migrate Data Load 
Parameters option was checked, all data load parameters were selected by default.  
 
 

 

Figure 5-12. Parameter Copy Utility - Cataloging Tab 

 
3. De-select any data load parameters that you do NOT want to copy.  
 

5.3.3 Performing Parameter Copying 
 
After you have connected to a source and target database and selected the parameters 
that you want to copy, you are ready to begin the parameter-copying process.  
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To perform the parameter-copying process,  
 
1. On the Parameter Copy Utility window, click the Copy button.  

 
A warning message appears (Figure 5-13).  
 
 

 

Figure 5-13. Copy Parameters Warning Message 

 

Important: Once you click the OK button, the parameter-copying process will 
begin. Parameter copying is irreversible. Click the OK button only if you are 
certain that you want to copy the selected parameters.  

 
2. If you are certain that you want to copy the selected parameters, click the OK 

button. 
 
Virtua performs a series of checks and may display one or more messages, asking 
you to provide some information.  
 

 First, Virtua checks to make sure that the target database is the same version as 
the source database.  

 
 If the database versions match, Virtua proceeds to the next check. 
 
 If the versions do NOT match, the following message appears (Figure 

5-14), indicating the version numbers of each database and asking you if 
you want to proceed.  
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Figure 5-14. Database Version Mismatch Message 

 
We recommend that you click No. 

 

 Next, Virtua checks whether you have chosen to copy the Users & Groups 
(i.e., User Profiles) parameter.  

 
 If you have chosen to copy the Users & Groups parameter, Virtua 

proceeds with the parameter-copying process.  
 
 If you have NOT chosen to copy the Users & Groups parameter, the Log-

in dialog box appears (Figure 5-15).  
 
 

 

Figure 5-15. Log-in Dialog Box 

 
The Log-in dialog box provides a mechanism for maintaining referential 
integrity for parameters that refer to Users & Groups when User Profiles 
are not copied. You must provide a valid username and password for the 
target database. The username you specify will be used to define the “Last 
Modified By” attribute of all copied parameters.   

 
After Virtua has performed the necessary checks and you have provided all the 
requested information, the parameter-copying process begins. You can monitor the 
progress of the parameter-copying process via the progress indicators on the 
Parameter Copy Utility window (Figure 5-16).  
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Figure 5-16. Parameter Copy Utility Window - Status of the Copy Process 

 

Note: If you access another application during the parameter-copying process, you will 
NOT be able to switch back to the Parameter Copy Utility window until the process is 
complete. If you want to monitor the progress of the parameter-copying procedure, do 
NOT switch to another application after you have started the copying process.  

 
After the parameter-copying process is complete, Virtua will generate an HTML report 
of the copying session and display it on your screen (Figure 5-17). 
 
 

 

Figure 5-17. Parameter Copy Report 
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Note: Virtua will prompt you with a Save dialog box so that you can save the report 
file ParameterCopyReport_date_time.html on your machine. 

 
The report contains a list of the parameters that were copied during your parameter-
copying session. Additionally, the report lists the parameters that were copied that rely 
upon other parameters.  
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6. Appendix A - Recommended 

Order for Setting Parameters 

 
The Virtua Profiler allows you to set parameters in any order, and you can modify your 
parameter settings whenever necessary. For maximum efficiency and to ensure the 
integrity of your database, however, we recommend that you set your Profiler 
parameters in the following order.  
 
1. Set the Currencies parameter. For details, see the Virtua Profiler/Global Settings 

User’s Guide.  
 

Note: If your Home currency is not yet set, see the System Management: Acquisitions 
User’s Guide. You will need to set your Home currency before you configure other 
currencies via the Currencies parameters.   

 
2. Set the Status Displays parameter. For details, see the Virtua Profiler/Global Settings 

User’s Guide.  
 
3. Set the Item Class Definitions parameter. For details, see the Virtua 

Profiler/Circulation Parameters User’s Guide.  
 
4. Set the Preservation and Conservation Codes parameter. For details, see the 

Virtua Profiler/Cataloging Parameters User’s Guide.  
 
5. Set the Location Names parameter. For details, see the Virtua Profiler/Global 

Settings User’s Guide. 
 
6. Set the Patron Types parameter. For details, see the Virtua Profiler/Circulation 

Parameters User’s Guide. 
 
7. Set the MARC Format Flag. For details, see the Virtua Profiler/Cataloging 

Parameters User’s Guide.  
 
8. Set your remaining Global Settings in any order. For details, see the Virtua 

Profiler/Global Settings User’s Guide.  
 
9. Set all remaining Cataloging parameters in any order. For details, see the Virtua 

Profiler/Cataloging Parameters User’s Guide.  
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10. Set all remaining Circulation parameters in any order. For details, see the Virtua 
Profiler/Circulation Parameters User’s Guide.  

 
11. Set the Fiscal Years parameter. For details, see the Virtua Profiler/Acquisitions 

Parameters User’s Guide. 
 
12. Set all remaining Acquisitions parameters. For details, see the Virtua 

Profiler/Acquisitions Parameters User’s Guide.   
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7. Appendix B - Changes in this 

Guide  

 

7.1 Changes for Version 16.1 

 
No changes were made. 
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